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Don’t leave your files languishing on your hard drive, get high-quality prints 
to display or share using the Epson Expression XP-960 inkjet

ewer of us are printing our 
images. After spending hours 
filling our memory cards in 
pursuit of the perfect image, it 

seems that many of us are happy to let the 
resulting files gather fluff on a hard drive. 
This, obviously, is a bad thing.

Producing a print is the ultimate 
accolade for your photographic 
endeavours. It’s a physical confirmation 
that you’ve produced shots to be proud of; 
shots that you want to instantly share with 
friends and family members or frame and 
put on a wall so everyone can enjoy them 
for years to come. That’s why we want to 
get photographers printing again and one 
of the best ways to produce a high-quality 
print that shows your work at its finest is 
to use an Epson inkjet printer.

Epson’s range of Expression models 
puts high-quality printing within reach of 
every photographer, regardless of space, 
ability or budget. The Expression range 
comprises three different line-ups: Home, 
Premium and Photo. 

As this brochure is all about getting the 
best prints possible, we tried the range-
topping Expression Photo XP-960. This 
model combines printing, scanning and 
copying functions for an all-round home 
printing solution. Here we’ve picked out 
just a small selection of our favourite 
features that will help you get high-quality 
results in a matter of minutes.

Getting connected
The XP-960 offers Wi-Fi connectivity so 
the only cable you have to plug in is the 
mains lead. What’s more, setting up the 
Wi-Fi connection couldn’t be easier. 

Pop the CD into your PC or Mac and let 
the software do the rest. Or, if you have 
one of the growing number of computers 
without a CD drive, just head to epson.sn 
and follow the on-screen instructions. 

The Wi-Fi Direct functionality means 
you don’t even have to connect to a 
wireless router – just connect straight to 
the printer. Either way, it takes less than 15 
minutes from unpacking the XP-960 for it 
to be ready for action!

The XP-960 also has its own email 
address for more versatile wireless 
functionality. This means you can print 
from a smartphone or tablet, and you 
can use cloud printing services to print 
from anywhere in the world! Plus, with 
Epson Connect, you can scan photos and 
documents direct to cloud-based storage 
such as Dropbox. 

The paper tray accepts a wide range 
of paper thicknesses and if you want to 
print onto thicker card, this can be fed 
through the back of the printer. Even CDs 
and DVDs can be printed on to using the 
removable tray. 

All-round versatility
To be honest, we were already sold on the 
XP-960’s capabilities simply after setting 
up and printing a selection of images, but 
it has much more to offer. 

For those times when you don’t want 
to print out high-quality images and just 
want to print documents, for example, the 
duplex (double-sided) printing option will 
save paper, plus the 4800dpi scanner can 
also be used as a copier. 

There are some fun features too, 
made possible by Epson’s Creative Print 
software. This gives you the option to 
print out personalised greetings cards, 
stationery and – our personal favourite – 
colouring book pages of your own images 
for the kids to colour in!

F

ABOVE The XP-960’s wireless connectivity 
allows you to print, scan and copy with ease.

BELOW The built-in card reader means you 
can print images without needing to even 
switch on your computer.

For those users who don’t want to use 
Wi-Fi, the XP-960 also provides standard 
Ethernet and USB connections.

Easy to use
With a whole host of features on offer, 
the XP-960 could be daunting to use, 
but it sports a refreshingly clean design 
thanks to the 10.9cm touchscreen control 
panel. Whether you want to print, scan or 
scroll through images on a memory card 
or change printer settings, it’s all done 
through the touchscreen and it’s as easy 
and intuitive as using a smartphone. 

The touchscreen panel also provides 
access to ink levels and displays simple 
status updates so you know exactly what 
the printer is doing. 

Impressive print quality
The XP-960 delivers a consummate 
printing performance that will show your 
work off at its very best, enabling you to 
print out at up to A3. 

Six Claria Photo HD inks are used to 
deliver great prints in both colour and 
black & white. They produce results that 
wouldn’t look out of place in an art gallery 
and will certainly grace any mantelpiece.

Two sizes of the Claria Photo HD inks 
are available – standard and XL for even 
better value for money – and with the 
vibrant colours, smooth tones and deep 
blacks we saw on offer, you wouldn’t want 
to use anything other than Epson’s own 
inks for the very best results. 

Using Epson’s inks also guarantees 
that your images will last a lifetime, and 
beyond. Store them carefully in a photo 
album and they’ll last up to 300 years.

As for the printer itself, the XP-960 
model features a motorised output tray 
so there’s no need to worry about prints 
getting mangled in the printer. 

 The XP-960 delivers a consummate  
printing performance that will show your 

work off at its very best EXPRESS YOURSELF!
Epson Expression XP-960
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y first taste of A3+ printing 
came a few years back when 
I sampled the delights of the 
Epson Stylus Photo R3000. As 

the owner of a DSLR with 20+ megapixels, 
I regularly had to downsize my images to 
print them out on my A4 unit at home. And 
while a high-quality A4 print can still cut it 
as a way to display images, there’s no doubt 
that when it comes to prints, bigger is most 
certainly better. Since I tried the R3000, I’ve 
never looked back and my orders to postal 
labs have become virtually non-existent.

Epson has recently introduced a 
replacement for the R3000, the SureColor 
SC-P600, and I’ve ploughed through 
plenty of ink and paper over the past few 
weeks trying its considerable charms. I 
was pleased to find that much of what I 
liked about the R3000 remained, but there 
have also been some significant updates, 
which means you get even better prints. 

While the old machine could never be 
described as ugly, I also think the SC-P600 
is smarter looking in its all black costume 
and is no larger than its predecessor, 
despite the extra features. 

The wonders of wireless
If you’re thinking of making the switch to 
an A3+ printer and are feeling daunted by 
the prospect, don’t worry, you’re amongst 
friends here. I used to think a bigger printer 
demanded a broader knowledge of the 
technology, yet the SC-P600 is remarkably 
easy to get up and running – largely due to 
the improved Wi-Fi functionality. 

Connecting it to a home or office 
broadband router is easily achieved 
and is the best way to go for out-and-out 
flexibility. This is because you can park the 

printer anywhere, rather than having to be 
tethered to a specific location. Of course, 
you can still connect by USB or Ethernet 
cable, but I stuck with Wi-Fi. The necessary 
drivers come supplied on a software CD, 
but as an owner of an Apple Mac without 
a CD drive, I was still able to get set up 
quickly, downloading the necessary from 
the Epson website at epson.sn.

The SC-P600 adds further Wi-Fi 
sophistication with the provision of 
Wi-Fi Direct, which enables printing from 
smartphones, tablets and PCs, plus it’s 
also compatible with Apple’s AirPrint and 
Google’s Cloud Print services.

Ease of use
Once up and running, I set to work. I’d 
already calibrated my monitor and would 
advise you to do the same, then chose to 
print all my images through Photoshop, 
allowing the software to manage the 
colours while I resized them before 
selecting paper type and image quality.

I started with the standard 1440dpi 
output, which produces an A3+ print in just 
over two and a half minutes – that’s a good 
30 seconds faster than the previous model 
– and found it to be more than adequate 

 From the moment your 
first A3+ print drops into 
the tray, you’ll be hooked 

for most of my shots. I used the ICC profiles 
that came as part of the downloadable 
software and if I found an image that I 
wanted to print at the ultimate quality, I 
went for the 5760dpi option. You can read 
the steps I went through to produce my 
prints on page 9 and I can safely say that 
the only rejects I had were user errors – the 
printer performed superbly.

Another improvement is the 6.8cm 
touchscreen, which can be tilted for ease of 
use. While it’s probably a tad smaller than 
the rear LCD on your DSLR, it’s bright and 
very easy to use. Ink levels are always on 
display and it also has an easy-to-use menu 
system should you want to run simple 
maintenance checks or use different 
print media. It also takes you through ink 
cartridge changing, step by step.

When it comes to printing on different 
paper, the SC-P600 is much like the R3000 
before it. Normal printing papers are fed 
through the rear, but thicker media can be 
fed through the front of the printer via a 
dedicated tray. There’s even the capacity 
to attach rolls of paper via the feeder 
supplied, plus the ability to print on to CDs 
and DVDs. 

Print quality
Trust me, from the moment your first A3+ 
print drops into the tray, you’ll be hooked. 
The print quality is truly exceptional. 
This is most likely down to the nine 
UltraChrome HD inks, the ninth colour 
being a Vivid Magenta to help produce an 
even wider colour gamut  
and the highest black density of any A3+ 
photo printer. The subtleties and tonal 
gradations are also stunning. The ink 
droplets are as small as 2pl, so fine details 
are beautifully rendered.

It’s the same when it comes to 
black & white prints, which are 
superb. I love the fact that you can add a 
tone to your monochrome work directly 
through the printer driver, which is just 
as good as any effect that I’ve spent ages 
faffing around with in Lightroom. 

Also impressive is the ink cartridge 
capacity. Each one holds 25.9ml of ink and, 
although the initial outlay will be higher 
than with an A4 printer, the SC-P600 will 
work out more cost-effective on a print-by-
print basis.

BELOW The Wi-Fi Direct connection means you 
can print from a smartphone or tablet without 
needing to connect to a network first.

ABOVE The smart-looking SC-P600 will look 
the part at home or in the office, and thanks to 
Wi-Fi connectivity, it can sit anywhere.

To really see your images in all their glory, 
print bigger. Epson’s SureColor SC-P600 A3+ 
printer is easy to use and delivers superb 
results as Roger Payne discovers

TOP Print on various media, including thicker 
papers, rolls and even CDs and DVDs with the 
SC-P600.

ABOVE Boasting nine UltraChrome HD inks, the 
SC-P600 outputs prints of exceptional quality 
time after time.

BIGGER IS
DEFINITELY 
BETTER

M

Epson SureColor SC-P600
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Among the long list 
of improvements to 
the SC‑P800 over its 
predecessor is the 
provision of a tilting 
touchscreen LCD. This 
more intuitive interface 
makes it easy to scroll 
through functions and 
quickly ascertain the 
printer’s status. Features 
at your fingertips include:

USING THE 
TOUCHSCREEN LCD

1) Paper Size
Offering up to 17", the 
SC‑P800 offers a huge 
range of other sizes, too.

2) Maintenance
The printer can be user 
maintained without 
having to call out an 
engineer – that’s useful 
extra functionality if time 
is money. You can keep an 
eye on the printer’s status 
and wireless connections 
through the Setup menu. 

3) Media Load Guide
The SC‑P800 takes paper 
and board up to 1.5mm 
thick. Use anything other 
than the Auto Sheet 
Feeder and step-by-
step instructions for 
loading appear on the 
touchscreen LCD.

ABOVE The nine pigmented inks are 
available in 80ml cartridges. This makes the 
SureColor SC-P800 more economical than 
smaller models.

ABOVE With the optional paper roll holder 
you can print panoramic images with ease.

hen was the last time you 
looked at the prints you supply 
to your clients? And when 
we say ‘look’ we don’t mean 

a cursory glance, we mean thoroughly 
studied the print quality. There are many 
high-quality labs around the country that 
will deliver fantastic results for you and 
your clients, but for real peace of mind 
and unrivalled quality control you can’t 
beat printing the images yourself, after all 
they’ll reflect well on your talent.

Epson produces a huge range of inkjet 
printers and media to cater for every 
printing need and budget. When it comes 
to the professional, however, one model in 
the range stands out as a real workhorse 
that can sit at the heart of any pro 
photographer’s workflow, the SureColor 
SC-P800. We took one for a test drive.

Outstanding versatility
The SureColor SC-P800 replaces the 
Stylus Pro 3880, the previous pro 
workhorse in the Epson line-up, and 
sports a range of new functions. One of 
the most significant for the pro user is 
the option to use rolls of paper via the 
optional roll paper unit – perfect if you 
want to print panoramic images or onto 
canvas up to 17 inches wide.  If you prefer 
to work on single sheets, the SC-P800 
also accepts up to 17” paper width and up 

to 1.5mm or 850 gsm thick. Despite this 
impressive media handling capability, it’s a 
relatively compact unit. It will comfortably 
fit into the corner of an office or studio, 
providing you leave enough space behind 
it to accommodate the heavier weight 
media that initially protrudes out of the 
back on loading. ‘Normal’ papers feed 
from the top and land in the extendable 
front tray. 

The SureColor SC-P800 uses the 
same Epson UltraChrome HD inks as the 

company’s large-format printers with nine 
pigmented inks delivering a huge range 
of colours and the deepest blacks of any 
A2 photo printer currently available. The 
inks are available in 80ml cartridges – an 
economical solution. 

Not only do you get great colour from 
the UltraChrome HD inks, they’re also 
designed to offer optimum longevity and 
reduce effects such as bronzing to keep 
your clients happy. The three level black 
ink technology ensures you get great 
mono results, too.

With the inks in place, the printer driver 
loaded and the nozzles checked, it was 
time to get down to printing. Another 
notable addition over the 3880 is the 
wireless connectivity. It makes computer 
to printer connection remarkably easy. 
You can use an existing Wi-Fi network, 
or simply connect directly to the printer 

making it easy to print from a PC, smartphone 
or tablet. Epson Connect, Apple AirPrint and 
Google Cloud Print services are also possible. 

High-quality prints in minutes
Once we were connected, we went straight for a 
borderless A2 print – who wouldn’t? – and were 
immediately impressed with the output quality. 
Two printing resolutions are available – 1440dpi 
and 2880dpi – both were excellent, but we’d be 
inclined to stick with the lower resolution and 
make those cartridges last a little longer. 

All the prints were produced through 
Photoshop where we left the software to manage 
the colour accuracy and chose the necessary 
profiles for the variety of media tested. All 
compatible profiles as supplied as part of the 
driver installation process. Third-party media 
profiles are also supplied but you may need to 
download additional ones. 

Producing high-quality prints that both 
you and your clients will be delighted with 
is extremely easy. Just as you would have 
produced test prints in the darkroom, getting the 
initial print right may take a few pieces of paper, 
but this likelihood is reduced with an accurately 
(and regularly) calibrated monitor, plus a few 
minutes spent tweaking settings.

When it comes to maintenance, the 
maintenance tank is user replaceable, which 
means you won’t have to pay for an engineer. 
That means less down time and more profit 
for your business. It’s also easy to keep an 
eye on printer functions thanks to the tilting 
touchscreen menu.

It’s hard to argue against taking more control 
of your printing output. Of course there’s the 
initial outlay for the printer, but doing so opens 
up a wealth of new revenue opportunities that 
today’s working pro would be foolish to dismiss. 

Producing high-quality prints that both you and your clients 
will be delighted with is extremely easy 

Printing images for clients keeps margins and quality high. 
We tried Epson’s SureColor SC-P800 inkjet to see just how 
much it offers the pro looking for a new revenue stream

PRINT YOUR WAY 
TO BETTER PROFITS

W

Epson SureColor SC-P800
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Photography is all about self-expression 
and that isn’t limited to how you frame 
an image or how you set the exposure, 
it also comes down to how you print 
the resulting file – and the media you 
use. Epson offers a vast range of printing 
media, all of which can be used to convey 
a different feeling or mood in your shots.

If you want to produce prints that will 
look great on any wall or mantelpiece, 
the more conventional Premium 
Gloss, Semigloss and Luster papers 
will deliver superb, bright colours that 

show your shots at their very best. But if 
you want to be more creative, consider 
one of the matte, fine art or traditional 
photo papers. Black & white images, 
meanwhile, look superb on Epson’s 
Hot and Cold Press papers, which are 
available in both Bright and Natural 
finishes, plus there are also canvas 
materials and thick boards that can be 
used to personalise your images further.  

For more on getting the best possible 
print, see the step-by-step guide on the 
page opposite.

The SureColor SC-P600 uses nine UltraChrome HD inks, which represent the pinnacle of 
Epson’s ink technology. UltraChrome inks are pigmented so they deliver superior results 
over dye-based inks on a wide variety of media, including a large gamut of colours, 
deeper blacks and impressive water resistance. Print longevity is also excellent – stored 
in optimum conditions, a print from the SC-P600 will last more than 200 years, so your 
work will be enjoyed by many generations to come!

Every aspect of cartridge manufacture is strictly monitored in Epson’s Telford plant, 
which produces more than 80% of the cartridges for the whole of Europe. From the 
moulding of the cartridge itself through to the ink that is put in it, all aspects are checked 
and double-checked throughout the manufacturing process to stringent quality control 
standards. There are also numerous patents covering the cartridges’ design, so although 
other cartridges claim to be the same, they aren’t. In short, using Epson’s inks ensures not 
only that you’ll get the best images, you’ll also extend the longevity of the printer itself.

You can get great prints straight out of the box, but 
spending a few minutes on each file helps you get 
consistent results every time. Here’s how we used the 
SureColor SC-P600 and Photoshop CC 2014 to get a 
perfect A3+ print

GET GREAT RESULTS, EVERY TIME

CHOOSING THE RIGHT MEDIA

ABOVE With rigorous quality control 
throughout production, Epson UltraChrome 

HD inks are guaranteed to produce excellent 
results, every time you print.

6) Final steps
Staying in Color Management, make 
sure Perceptual is selected in the 
Rendering Intent menu. Click the black 
triangle next to Color Management, or 
simply scroll down in the same window 
to find the Position and Size option. 
Here you can choose where and how 
big the image prints using the preview 
on the left to see what you’re getting. 
When you’re happy, hit Print and let the 
SC‑P600 do the rest.

4) Make corrections as required
Once the ICC profile is selected, from 
the Rendering Intent menu choose 
Perceptual, then make sure that the 
Black Point Compensation and Simulate 
Paper Color boxes are both ticked.

Now click on Preview to view what 
the image will look like. There could be a 
large difference, in which case you may 
want to bring the duplicated copy as 
close to the original as possible before 
printing. Once you’re happy, you can 
save the profile and give it a name by 
clicking on Save, or simply OK if you 
want to move on. 

Stick with Epson inks and paper and you’ll be producing 
great prints in no time. We show you how simple it is to get 
results good enough to hang on your wall

hen it comes to getting great 
prints of your favourite 
photographs, the best option is 
to take matters into your own 

hands. And the best way to do that  
is to print your images at home using one 
of the comprehensive range of Epson 
inkjet printers. Packed with the latest 
inkjet technology and user-friendly 

features including wireless connectivity, 
Epson’s latest models deliver high-quality 
results, print after print, and are far more 
economical than going to either a high 
street or professional lab.

Models such as the Epson SureColor SC-
P600 enable you to produce high-quality 
A3+ prints at home, but many users make 
the common mistake of buying the printer 

and then skimping on media or inks. That’s 
akin to cooking fillet steak and serving it up 
on paper plates! While Epson papers and 
inks may cost that little extra compared 
to some third-party products, there’s good 
reason for that. And after taking a trip to 
the company’s ink manufacturing plant 
in Telford, we’ve seen at first-hand exactly 
why that is. 

PRODUCE YOUR 
BEST EVER PRINTS

Print longevity is excellent – stored in optimum 
conditions,  a print will last more than 200 years 

THE SECRET’S IN THE INK

ABOVE Thanks to Epson’s wide range of 
media you’ll always find the right paper.

2) Set up for soft proofing
Soft proofing enables you to check that 
what you see on screen is what you’ll 
get on the resulting print. With the image 
open in Photoshop, start by creating a 
duplicate (Image>Duplicate) and on the 
duplicated version perform a Gamut 
Warning by choosing View>Gamut 
Warning (shortcut Ctrl+Shift+Y). This 
will give you a quick visual indication of 
the areas of the image that may not print 
exactly as they are on screen. That’s 
because monitors have a wider gamut 
than printers. If it’s a large area, you may 
wish to make some tweaks to the image. 

5) Preparing to print
Select File>Print to open Photoshop’s 
Print dialogue box. Start in the Printer 
Setup section, click on Print Settings 
and from the correct Paper Size before 
hitting Save, then choose the correct 
Layout orientation. Move to the Color 
Management box and under Color 
Handling choose Photoshop Manages 
Colors then select the correct ICC profile 
from the Print Profile menu.

1) Make sure your monitor is calibrated
Monitor calibration is vital in your quest 
for consistently high-quality prints, so 
if you don’t have a monitor calibrator, 
we’d advise you to get one. A variety 
of models are available, but they all do 
essentially the same thing, ensuring 
that what you see on the screen is what 
you get from the printer. Be sure to 
recalibrate your monitor regularly – at 
least once a month – and more often if 
you do a lot of printing. 

3) Use the correct ICC profile
The software supplied with the SC‑P600 
contains a number of different ICC 
profiles for different Epson media. In 
addition for being used to print out, 
these profiles are used for soft proofing. 
Select View>Proof Setup>Custom and 
the Customize Proof Condition dialogue 
box will open. Under the Device to 
Simulate pop-up menu, select the 
correct profile for the printer and media 
you’re using. If the profile isn’t available, 
visit the Epson website. 

 Soft proofing enables you to check that what you 
see on screen is what you’ll get on the print 

W

Make better prints
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1) Convert your image to black 
& white
Using Photoshop CC 2014, 
we converted the original 
colour image to black & white 
with the Channel Mixer 
(Image>Adjust>Channel 
Mixer). Don’t use the Grayscale 
conversion as this gets rid of 
lots of vital image data. Make 
any further tweaks until it 
looks perfect on screen. 

COLOUR ORIGINAL

2) Let the printer manage 
colours
Go to File>Print to open the 
Photoshop print dialogue. 
Leave the printer to manage 
the colours so in the Color 
Management section set 
Color Handling to Printer 
Manages Colors. Further down 
in the same section, choose 
Perceptual on the Rendering 
Intent menu. 

3) Select Printer Settings
Now move to the Printer 
Setup section at the top of 
the dialogue box. Click the 
Print Settings button and in 
the window that opens make 
sure the correct Paper Size is 
selected. Now choose Color 
Matching from the drop-
down menu and make sure 
that EPSON Color Controls is 
selected. 

4) Select Advanced B&W 
settings, then print
From the same drop-down 
menu, choose Print Settings 
and Advanced B&W from 
the Color menu. From Color 
Toning select your tone of 
choice, then hit Save. Now, 
back in the Photoshop box 
go to the Position and Size 
section, and size up the image 
accordingly. Finally, hit Print.

MONO IMAGE

“I have a wonderful 
passion for taking 
pictures and I want 
to get that passion for 
actually producing really 

good prints. I have been involved 
with Photoshop since 1995, but due 
to personal circumstances I’ve had a 
two-year gap. This course was a way 
of giving me back my confidence. It’s 
not only a refresher but as everything 
moves on, it’s about bringing me back 
up to date as well.

“I chose this Epson Print Academy 
class because it’s run by Aspect2i.  
Having been on some of their 
workshops out in the field, I knew I was 
going to get really good tuition on a post 
processing masterclass.  The other class 

I attended was a Lightroom workshop, 
which was a completely new program 
to me, and I knew the place to learn it 
would be on an Epson Print Academy 
run by Aspect2i.   

“So far, it’s been brilliant, absolutely 
wonderful.  The class covers 
everything and is suited to those who 
only just know how to use Photoshop, 
through to those who are more 
advanced but still want to learn new 
techniques. 

“For me the class is about making 
sense of things that I have seen done, 
but not really understood how to do 
them myself.  I know that by the end 
of the class I will be able to produce a 
print that mirrors the picture that I took 
in the first place.”

ABOVE  On an Epson Print Academy, you’ll 
get plenty of guidance from expert tutors to 

make your prints reach their full potential. 

CASE STUDY: NAOMI
Knee-deep into a three-day Post Processing and Printing 
Masterclass, Naomi tells us how she’s getting on

Improving your skills

 So far, it’s been 
brilliant, absolutely 

wonderful… The class 
covers everything 

Want to produce black & white prints as 
good as the pros’? It’s easy with the Epson 
SureColor SC-P600

PRINT PERFECT BLACK & WHITES

The real acid test for an inkjet printer is its ability to print black 
& white images. Epson’s SureColor SC-P600 offers an advanced 
black & white printer driver and three black inks to deliver a 
superb range of tones. Better still, you can even select a tone to add 
to your monochrome images. Here’s how you can create brilliant 
black & white prints in four simple steps. We used a Mac, on a PC 
the layout is slightly different, but it’s just as easy 

Make your pictures the best they can be by upskilling in post-production 
and printing with the Epson Print Academy

PRETTY AS A PRINT
aking a great photograph is 
only the start of the journey. 
Mastering your camera is one 
thing, but knowing what to 

do with your photos next is a different 
realm of image manipulation, editing and 
printing – making your photography skills 
really shine through post-processing and 
printing techniques. Sure you could have 
a fiddle around in Photoshop and connect 
up your printer and have a go at getting 
frame-worthy prints, or you can make like 
an expert and have Epson’s experienced 
tutors show you the ropes, whatever level 
you’re coming in at.

Epson has teamed up with Aspect2i 
to deliver their Epson Print Academy 
classes. Aspect2i have been helping 
photographers make perfect prints 
for around five years and are one of 
the leading photography workshop 
companies in the UK. So rest assured 
you’ll be in capable hands. There’s no 
typical kind of person who comes along 
to the Epson Print Academy; total newbies 
looking to pick up basic post-processing 
or printing skills will benefit just as much 

as those with more experience wanting to 
hone their expertise even further. 

There are classes aplenty to choose 
from covering a whole range of specialist 
interests and techniques, so whatever 
your niche, you’ll find something to suit 
your experience and interests at the 
Epson Print Academy. 

Looking to show off your work in a 
gallery or submit your images to a print 
competition? The Exhibition Quality 
Printing class will hook you up with 
expert advice from pros in fine print 
reproduction, printmaking and proofing. 
If you can’t quite nail black & white prints, 
at the end of the Perfect Black and White 
Print class you’ll know exactly how to 
manage your workflow for truly magical 
monochrome prints from your Epson 
printer. In fact, there are masterclasses 
in everything from post-processing, to 
Lightroom and Photoshop, right through 
to Advanced Post Processing and Printing 
for the more experienced shooter.

These aren’t the types of classes where 
you’re packed in and lost in a crowd. Far 
from it. 

Groups are kept small so you’ll be 
getting plenty of face time with your 
tutor and lots of opportunities to receive 
tailored expert advice and pro guidance.

Take those photographs you’re 
proud of and make prints you’re 
even prouder of, all with a little help 
from the Epson Print Academy.

>> More information
www.epson.co.uk/printacademy
www.aspect2i.co.uk

T

ABOVE  Produce exhibition worthy prints with 
pro help on an Epson Print Academy class.

 You’ll get plenty of face time with your tutor and lots 
of opportunities to receive tailored expert advice 
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Before you start scanning, 
we recommend you use 
the i1 Profiler to create 
a bespoke ICC scanner 
profile to guarantee more 
accurate colours right 
from the off. Here’s how: 

USING THE i1 
PROFILER

1) Once you’ve installed 
the software, place the 
supplied target 4x5in 
transparency or 5x7in 
print on the plate. Turn 
off any colour corrections 
and save the resulting 
file as a .tif. This creates a 
‘before’ scan.

2) Follow the on-screen 
instructions to load up 
a Reference file. The 
software assesses the 
differences between the 
two and creates a profile. 
Before you save the 
profile, make sure you 
have ICC Profile Version 2 
selected.

3) In the Epson Scan 
software, choose the 
Professional scanning 
mode and at the bottom 
of the dialogue box, 
choose Configuration. 
Now check the Color 
Sync box and from the 
Source drop-down menu 
choose the profile you’ve 
just named – in our case 
Scanner.icc. Scan the 
same target again and 
look at the difference!

lthough it may be hard 
to believe, there was 
photographic life before 
the world turned digital. 

Photographers used to be limited by the 
number of exposures they could take 
in one go and typically had to wait a few 
days to see results of their endeavours. 
Crazy, we know. 

But if you remember this bygone 
era, the chances are, you’ll have some 
silver halide proof of this in the form of 
transparencies, negatives or maybe some 
well-thumbed prints that have seen better 
days. What’s more, the chances are these 
will be in a shoebox under the bed. Or at 
the back of a cupboard. Or in the shed 
awaiting their final trip to the skip.

Casting old images aside like this 
is common, but it’s also something of 
a travesty. Not only will you have an 
emotional connection with the images 
that you captured on film, the chances are 
you’ll have some really good photographs 
that simply haven’t seen the light of day 
for years. 

Scanning your images is the perfect 
way to ensure they’ll stand the test of time 
and Epson produces a range of excellent 
models that can enhance your shots 
without you having to go anywhere near 
Photoshop. To see just how easy it is make 

your memories digital, we set up the 
Perfection V850 Pro, grabbed a selection 
of slides from the early 1990s and got 
down to work.

Simple set-up
Just like Epson’s inkjet printers, the V850 
Pro proved to be remarkably simple to 
set up. There’s no Wi-Fi capability here, 
just a good old USB cable, so it’s simply a 
question of installing the software from the 
supplied CD and you’re ready to go. As we 
were using an Apple Mac that didn’t have a 
CD drive we had to download the software 
from the Epson website at epson.sn then 
follow the simple on-screen instructions. 

As well as the scanner drivers, the V850 
Pro also comes with a copy of SilverFast 
SE Plus 8 and X-Rite i1 Profiler. The former 
is scanning software, the latter gets the 
device calibrated. We chose not to install 
SilverFast, sticking with the familiar Epson 
Scan software that comes with Epson’s 
all-in-one printers, but did choose to use 
the X-Rite software. For the reasons why, 
see the panel (right). The X-Rite software 
did a great job, but does slow the process 
down a little as updates were required 
and after each installation the computer 
had to be restarted.

The V850 Pro itself is anything but 
slow. Thanks to the use of Epson’s 
ReadyScan LED light source which warms 
up in under a second, it was ready to go 
virtually instantly.

Feature packed
Sitting at the top of Epson’s range of 
scanners, the V850 Pro comes packed 
with features. A dual lens scanning 
system enables both negatives and 
transparencies up to 8x10in to be scanned 
at a maximum resolution of 6400dpi, 
while prints up to A4 can be scanned at 
4800dpi – both are more than enough to 
ensure sizeable images should you want 
to print out later. 

Two sets of film holders are supplied so 
you can load one holder while the other 
is being scanned to avoid interruptions to 

your workflow. The holders themselves 
are height adjustable so you can be 
confident of getting a razor sharp scan.

When it comes to the actual 
scanning, a range of features are built 
in to the Epson Scan software to help 
you get the best results. The Digital 
ICE technology is highly effective in 
reducing dust, hair, scratches and other 
gremlins, while the Color Restoration 
function is handy if you’re scanning 
in older images where the colours 
have faded over time. The three 
levels of Backlight Correction are also 
useful to help lift images where the 
subject is silhouetted against a bright 
background.

The Epson Scan interface is 
simple enough to use. Three modes 
are available: Full Auto, Home and 
Professional and we’d suggest the latter 
to get the very best from your images. 
While the V850 isn’t the quietest 
machine in operation, it certainly 
delivers impressive scans. The optical 
density of 4.0DMax means that even 
the most subtle difference in tonal 
shades will be picked up to ensure you 
get wonderfully clear results.

The quality we got from the V850 
Pro means that there’s no excuse to let 
old film shots go to waste. Rescue them 
from that ‘ready for the bin’ pile and 
breathe new life into your shots.

TOP Clean and simple design makes the 
Perfection V850 Pro simple to use.

 The V850 Pro is 
anything but slow. 
Thanks to the use of 
Epson’s ReadyScan LED 
light source,  
it was ready to go 
virtually instantly 

ABOVE The range-topping V850 Pro is 
packed with features so you’ll be able to get 
the best results from old prints and film.

RIGHT For a smooth workflow, there are two 
film holders so you can load one while the 
other is being scanned. 

BEFORE PROFILING 

AFTER PROFILING

Start scanning film and prints to breathe new life into your 
pre-digital shots. We tried the Perfection V850 Pro to see 
how easy it is

REVIVE YOUR 
OLD IMAGES 

A

Epson Perfection V850 Pro



Give your images the exposure they deserve by projecting them using an Epson 
digital projector. We round up the models and features to look out for

IT’S SHOWTIME!

Our top tips for picking 
the right projector for 
your needs:

Lumens
Refers to how bright the 
projector is. More lumens 
= more brightness. Lumen 
ratings should be supplied 
for both colour brightness 
and white brightness. 
If only one number is 
provided, the chances are 
it will only be for white, 
which can be misleading 
as colour brightness can 
often be much lower.

Resolution
Like any digital product, 
resolution is measured 
in pixels. The higher the 
resolution, the more detail 
you’ll see. You’ll typically 
find a projector is either 
XGA (1024x768 pixels), 
WXGA (1280x800 pixels) 
or WUXGA (1920x1200 
pixels). 

Contrast ratio
The difference between 
the brightest white and the 
darkest black on screen. 
A contrast ratio of 1000:1 
means that the brightest 
white is 1000x brighter 
than the darkest black. 
Naturally, the bigger the 
contrast ratio the better 
the tonal gradation and 
the more detail on show.

Image adjustments
Horizontal and vertical 
keystoning, for example, 
avoid distortion from the 
projector being placed 
at an angle to the screen 
and lens shift ensures you 
keep sharp focus across 
the projected image in the 
same circumstances.

Ease of use
Avoid wasting time setting 
up by choosing a model 
with an HDMI connection 
or wireless capability. 

f you want to show your 
images to a wider audience, 
the best way to do it is through 
projection. Thankfully, the 

days of transparencies getting stuck in 
projectors or being displayed the wrong 
way round are long gone. Contemporary 
digital projectors are slick, powerful and 
show your work off at its very best.

Epson provides a wide range of digital 
projectors that are suitable for a variety of 
applications, plus they come with a range 
of simple connectivity options to ensure 
you won’t keep your audience waiting. It’s 
also worth pointing out that far from being 
only suitable for showing images, Epson 
projectors can also be used to connect 
devices such as games consoles, home 
cinema systems and HD video cameras, 
making them true multimedia devices.

Our experiences of working with Epson 
digital projectors are nothing but positive. 
To keep things as simple as possible, 
we chose not to project images from a 
computer or wireless device and elected 
instead to put the edited shots on to a 
flash drive, which plugged into the USB 
socket and was instantly recognised by 
the device. It was then just a case of using 
the remote control to run through the set.

If you’re considering investing in a 
digital projector, we’d recommend one of 
the following three models depending on 
your budget and projection requirements.

EB-U32
A great model for both home and 
office use. It offers the highest WUXGA 
resolution, has a bright 3200 lumens 
output for both white and colour 
brightness and a 15,000:1 contrast ratio. 
Equally impressive is the lamp and air 
filter life; if you were to use the projector 
to watch a movie every day, it would be 15 
years before you needed to change either.

Connectivity is also one of the EB-U32’s 
strong points. It boasts two HDMI inputs 
and comes with Wi-Fi built-in so you can 
connect from a smartphone or tablet. 

Automatic vertical keystone correction 
coupled with horizontal keystone 
correction make it easy to get a perfect 
projected image.

EH-TW6600
The EH-TW6600 is equally at home 
projecting images as it is being used 
to display movies and games at Full 
HD resolution. It uses Epson’s 3LCD 
technology to ensure there’s no trade-off 
in colour and brightness, plus it has an 
impressive 70,000:1 contrast and a bright 
2500 lumens output. 

A recent What Hi-Fi test winner, the 
EH-TW6600 comes with two HDMI 
inputs and two 10W stereo speakers; 
perfect if you want to add a soundtrack 
to accompany your shots. There’s also a 
full range of image correction features so 
you’ll be up and running in no time.

EB-4950WU
Perfect for the photographer who 
wants to show his work to large 
audiences in equally large venues. 

With WUXGA resolution and a 
powerful 4500 lumens output, the 
EB-4950WU won’t be found wanting 
when it comes to image brightness, while 
the 5000:1 contrast ratio will ensure that 
your audience will see plenty of detail.

A wide range of connectivity options 
are available, plus a wireless LAN 
connection is also available as an optional 
extra. You can even use the split screen 
function so you can plug in two devices 
for a true multimedia extravaganza! 

HOW TO CHOOSE  
A PROJECTOR

EB-U32

RIGHT  If you’re looking 
for versatility, choose 
a projector with plenty 
of connectivity options. 
It’s one of the EB‑U32’s 
strong points. 
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 If you’re considering investing in a digital projector, 
we’d recommend one of these three models depending 

on your budget and requirements 
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IMAGE Whether’s 
it’s Full HD movies 
or games, or stills, 

you’re projecting, the 
EH‑TW6600 is equally 

at home. 

EH-TW6600

EB-4950WU

IMAGE Prefect for 
projecting images 
in large venues, the 
EB‑4950WU.

I

Epson digital projectors
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